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ComponentOne Olap for WinForms 
Overview

Create grids, charts, and ad-hoc reports that can be saved, exported, or printed in no time with 
ComponentOne Olap for WinForms. Use a single control, C1OlapPage, which provides a complete OLAP 
user interface, or customize your application with the C1OlapPanel, C1OlapGrid, C1OlapChart, and 
C1OlapPrintDocument controls.

Olap for WinForms Quick Start
This section presents code walkthroughs that start with the simplest C1Olap application and progress to 
introduce commonly used features.

Creating OLAP Views
Run the application and you will see an interface similar to the one in Microsoft Excel. Drag the "Country" 
field to the "Row Fields" list and "ExtendedPrice" to the "Value Fields" list, and you will see a summary of 
prices charged by country as shown below:

Click the "Olap Chart" tab and you will see the same data in chart format, showing that the main customers 
are the US, Germany, and Austria. 

Now drag the "Salesperson" field into the "Column Fields" list to see a new summary, this time of sales per 
country and per sales person. If you still have the chart tab selected, you should be looking at a chart similar to 
the previous one, except this time the bars are split to show how much was sold by each salesperson:
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Move the mouse over the chart and you will see tooltips that show the name of the salesperson and the 
amount sold when you hover over the chart elements.

Now create a new view by swapping the "Salesperson" and "Country" fields by dragging them to the opposite 
lists. This will create a new chart that emphasizes salesperson instead of country:
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The chart shows that Margaret Peacock was the top salesperson in the period being analyzed, followed closely 
by Janet Leverling and Nancy Davolio.

Creating OLAP Reports
This is an interesting chart, so let’s create a report that we can e-mail to other people in the company. Click the 
"Report" button at the top of the page and you will see a preview showing the data on the first page and the 
chart on the second page.  In the Print Preview dialog box, click the "Page Setup" button and change the page 
orientation to landscape. The report should look like this:

Now you can print the report or click the "Export to PDF" button to generate a PDF file that you can send to 
others or post on the web.

Close the preview window and save this view by clicking the "Save" button. You can create and save as many 
views as you like.

Copying Data to Excel
The built-in reports are convenient, but in some cases you may want to copy some or all the data to Excel so 
you can perform additional analyses including regressions, create customized reports by annotating the data or 
adding custom charts.

The C1OlapGrid supports the clipboard by default, so you can simply select the data you are interested in, 
press Control + C, then paste it directly into an Excel sheet. The row and column headers are included with 
the data.

Summarizing Data
Before we move on to the next example, let’s create a new view to illustrate how you can easily summarize 
data in different ways.

First, uncheck the check box next to the County field to remove countries from the view.
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This time, drag the "Salesperson" field to the "Row Fields" list and the "OrderDate" field to the "Column 
Fields" list. The resulting view contains one column for each day when an order was placed. This is not very 
useful information, because there are too many columns to show any trends clearly. We would like to 
summarize the data by month or year instead.

One way to do this would be to modify the source data, either by creating a new query in SQL or by using 
LINQ. Both of these techniques will be described in later sections. Another way is simply to modify the 
parameters of the "OrderDate" field. To do this, right-click the "OrderDate" field and click Field Settings. 
Then select the "Format" tab in the dialog box, choose the "Custom" format, enter "yyyy", and click OK. 

The dates are now formatted and summarized by year, and the OLAP chart looks like this:

If you wanted to check how sales are placed by month or weekday, you could simply change the format to 
"MMMM" or "dddd".
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Drilling Down on the Data
As we mentioned before, each cell in the OLAP grid represents a summary of several records in the data 
source. You can see the underlying records behind each cell in the OLAP grid by right-clicking it with the 
mouse.

To see this, click the "Olap Grid" tab and right-click the first cell on the grid, the one that represents Andrew 
Fuller’s sales in 1996. You will see another grid showing the 40 records that were used to compute the total 
displayed in the Olap grid:
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Key Features
The following are some of the main features of ComponentOne Olap for WinForms that you may find useful:

• Olap for WinForms provides ultimate flexibility for building OLAP applications
Drop one control, C1OlapPage, on your form and set the data source to start displaying your data in a grid or 
chart–it's that easy! But suppose you need to show multiple charts or grids. No problem. Olap for WinForms
also provides the C1OlapPanel, C1OlapChart, and C1OlapGrid controls to give you the flexibility you need. 
See the C1Olap Architecture (page 9) for an overview of each of the controls.

• Choose from five chart types and twenty-two palette options to enhance your charts
C1OlapChart provides the most common chart types to display your information, including: Bar, Column, 
Area, Line, and Scatter. You can select from twenty-two palette options that define the colors of the chart and 
legend items. See Using the Chart Menu (page 13) to view all of the chart types and palettes.

• Print, preview, or export data to PDF
You can create and preview reports containing data, grids, or charts and then print or export them to PDF. See 
Creating OLAP Reports (page 3) and the Olap for WinForms Task-Based Help (page 24) for more 
information.

• Remove a field or data in a field from the grid or chart view
You can easily filter a field so it doesn't appear in your grid or chart view. Simply drag the field to the Filter
area of a C1OlapPanel; see Removing a Field from a Data View (page 24) for more information. If you want 
to filter on data in a field, for example, if you want to find all employees whose last names start with "Sim", 
you can use the Field Settings dialog box. See Filtering Data in a Field for detailed steps.

• Display information in a grid or chart view
Olap for WinForms provides a C1OlapGrid and C1OlapChart control to display data. These controls are built 
into the C1OlapPage control, but they are also available as separate controls so you can customize your OLAP 
application. See the C1Olap Architecture (page 9) for an overview of each of the controls.

• Decide how information is displayed at run time
Use the C1OlapPanel to determine which fields of your data source should be used to display your data and 
how. Drag fields between the lower areas of the C1OlapPanel to create a filter, column headers, row headers, 
or get the sum of values from a column or row. For more information, see C1OlapPanel (page 10).
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What is C1Olap
ComponentOne Olap for WinForms (C1Olap) is a suite of .NET controls that provide analytical processing 
features similar to those found in Microsoft Excel’s Pivot Tables and Pivot Charts. 

C1Olap takes raw data in any format and provides an easy-to-use interface so users can quickly and intuitively 
create summaries that display the data in different ways, uncovering trends and providing valuable insights 
interactively. As the user modifies the way in which he wants to see the data, C1Olap instantly provides grids, 
charts, and reports that can be saved, exported, or printed.

Introduction to Olap
OLAP means "online analytical processing". It refers to technologies that enable the dynamic visualization 
and analysis of data.

Typical OLAP tools include "OLAP cubes" and pivot tables such as the ones provided by Microsoft Excel. 
These tools take large sets of data and summarize it by grouping records based on a set of criteria. For 
example, an OLAP cube might summarize sales data grouping it by product, region, and period. In this case, 
each grid cell would display the total sales for a particular product, in a particular region, and for a specific 
period. This cell would normally represent data from several records in the original data source.

OLAP tools allow users to redefine these grouping criteria dynamically (on-line), making it easy to perform 
ad-hoc analysis on the data and discover hidden patterns.

For example, consider the following table:

Date Product Region Sales
Oct 2007 Product A North 12
Oct 2007 Product B North 15
Oct 2007 Product C South 4
Oct 2007 Product A South 3
Nov 2007 Product A South 6
Nov 2007 Product C North 8
Nov 2007 Product A North 10
Nov 2007 Product B North 3

Now suppose you were asked to analyze this data and answer questions such as:

• Are sales going up or down?

• Which products are most important to the company?

• Which products are most popular in each region?

In order to answer these simple questions, you would have to summarize the data to obtain tables such as 
these:

Sales by Date and by Product
Date Product A Product B Product C Total
Oct 2007 15 15 4 34
Nov 2007 16 3 8 27
Total 31 18 12 61
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Sales by Product and by Region
Product North South Total
Product A 22 9 31
Product B 18 18
Product C 8 4 12
Total 48 13 61

Each cell in the summary tables represents several records in the original data source, where one or more 
values fields are summarized (sum of sales in this case) and categorized based on the values of other fields 
(date, product, or region in this case).

This can be done easily in a spreadsheet, but the work is tedious, repetitive, and error-prone. Even if you wrote 
a custom application to summarize the data, you would probably have to spend a lot of time maintaining it to 
add new views, and users would be constrained in their analyses to the views that you implemented.

OLAP tools allow users to define the views they want interactively, in ad-hoc fashion. They can use pre-
defined views or create and save new ones. Any changes to the underlying data are reflected automatically in 
the views, and users can create and share reports showing these views. In short, OLAP is a tool that provides 
flexible and efficient data analysis.
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C1Olap Architecture
C1Olap includes the following controls:

C1OlapPage
The C1OlapPage control is the easiest way to develop OLAP applications quickly and easily. It provides a 
complete OLAP user interface built using the other controls in C1Olap. The C1OlapPage object model 
exposes the inner controls, so you can easily customize it by adding or remove interface elements. If you want 
more extensive customization, the source code is included and you can use it as a basis for your own 
implementation.

The diagram below shows how the C1OlapPage is organized:
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In Visual Studio, the control looks like this:

C1OlapPanel
The C1OlapPanel control is the core of the C1Olap product. It has a DataSource property that takes raw data 
as input, and an OlapTable property that provides custom views summarizing the data according to criteria 
provided by the user. The OlapTable is a regular DataTable object that can be used as a data source for any 
regular control.

The C1OlapPanel also provides the familiar, Excel-like drag and drop interface that allows users to define 
custom views of the data. The control displays a list containing all the fields in the data source, and users can 
drag the fields to lists that represent the row and column dimensions of the output table, the values 
summarized in the output data cells, and the fields used for filtering the data.

At the core of the C1OlapPanel control, there is a C1OlapEngine object that is responsible for summarizing 
the raw data according to criteria selected by the user. These criteria are represented by C1OlapField objects, 
which contain a connection to a specific column in the source data, filter criteria, formatting and summary 
options. The user creates custom views by dragging C1OlapField objects from the source Fields list to one of 
four auxiliary lists: the RowFields, ColumnFields, ValueFields, and FilterFields lists. Fields can be 
customized using a context menu.

Notice that the C1Olap architecture is open. The C1OlapPanel takes any regular collection as a DataSource, 
including data tables, generic lists, and LINQ enumerations; it then summarizes the data and produces a 
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regular DataTable as output. C1Olap includes two custom controls that are optimized for displaying the 
OLAP data, the C1OlapGrid and C1OlapChart, but you could use any other control as well.

The C1OlapPanel looks like this:

C1OlapPanel Area Description

Filter Specifies the field to filter.

Row Field The items in the field specified become the row headers of a grid. These 
items populate the Y-axis in a chart.

Column Fields The items in the field specified become the column headers of a grid. 
These items are used to populate the legend in a chart.

Values Shows the sum of the field specified.

If you right-click fields in the Filter, Column Fields, Row Fields, or Values area at run time, a context menu 
appears, allowing you to move the field to a different area. You can also remove the field or click Field 
Settings to format and apply a filter to the field. See Filtering Data in a Field (page 24) for more information.
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C1OlapGrid
The C1OlapGrid control is used to display OLAP tables. It extends the C1FlexGrid control and provides 
automatic data binding to C1OlapPanel objects, grouped row and column headers, as well as custom 
behaviors for resizing columns, copying data to the clipboard, and showing details for any given cell. 

The C1OlapGrid control extends the C1FlexGrid control, our general-purpose grid control. This means the 
whole C1FlexGrid object model is also available to C1Olap users. For example, you can export the grid 
contents to Excel or use styles and owner-draw cells to customize the grid’s appearance.

To populate C1OlapGrid, bind it to a C1OlapPanel that is bound to a data source. 

For more information on the C1FlexGrid control, see the ComponentOne FlexGrid for WinForms
documentation.

C1OlapChart
The C1OlapChart control is used to display OLAP charts. It extends the C1Chart control and provides 
automatic data binding to C1OlapPanel objects, automatic tooltips, chart type and palette selection.

The C1OlapChart control extends the C1Chart control, our general-purpose charting control. This means the 
whole C1Chart object model is also available to C1Olap users. For example, you can export the chart to 
different file formats including PNG and JPG or customize the chart styles and interactivity.

To populate C1OlapChart, bind it to a C1OlapPanel that is bound to a data source. 

For more information on the C1Chart control, see the ComponentOne 2D Chart for WinForms
documentation.

C1OlapPrintDocument
The C1OlapPrintDocument component is used to create reports based on OLAP views. It extends the 
PrintDocument class and provides properties that allow you to specify content and formatting for showing 
OLAP grids, charts, and the raw data used to create the report.

For more information, see the ComponentOne Reports for WinForms documentation.
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Using the C1OlapPage ToolStrip
The C1OlapPage control provides a ToolStrip you can use to: load or save a C1OlapPage as an .xml file, 
display your data in a grid or chart, or setup and print a report. The following table describes the buttons in the 
ToolStrip.

Button Description

Load Allows you to load a previously saved C1Olap view definition file 
(*.olapx) into the C1OlapPage.

Save Allows you to save a C1Olap view definition file (*.olapx).

Grid Allows you to choose the columns and rows to display in the 
C1OlapGrid.

Chart Allows you customize the chart used to display your data. You can 
determine: the chart type, the palette or theme, whether the title will 
appear, whether the chart is stacked, and whether gridlines appear.

Report Allows you to: specify a header or footer for each page of the report; 
determine what to include in the report, the Olap grid, chart, or raw 
data grid; specify the page layout, including orientation, paper size, and 
margins; preview the report before printing; and print the report.

Using the Grid Menu
The Grid menu provides three options:

Show Totals 
Column

Shows a column to the right of the last column in your grid which totals all the data in 
the row.

Show Totals Row Shows a row at the bottom of your grid which totals all the data in the column.

Show Zeros If checked, shows any cells containing zero in the grid.

Simply uncheck any of these items to hide the totals column, totals row, or any zeros in the grid.

Using the Chart Menu
From the Chart menu, you can  determine: the chart type, the palette, whether to show the chart title above 
the chart, whether to show a stacked chart, and  whether to show chart gridlines.
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Chart Type Click Chart Type to select from five common chart types shown below.

Palette Click Palette to select from twenty-two palette options that define the colors of the 
chart and legend items. See the options in the Palette topic below.

Show Title When selected, shows a title above the chart.

Stacked When selected, creates a chart view where the data is stacked.

Show Gridlines When selected, shows gridlines in the chart.

Chart Types

ComponentOne Olap for WinForms offers five of the most common chart types. The following table shows 
an example of each type.

Bar 
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Column  

Area 

Line 
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Scatter 

Palette

The C1OlapChart palette is made up of twenty-two options that define the colors of the chart and legend 
items. The following table shows the colors for each palette option.

Standard Office GrayScale
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Apex Aspect Civic

Concourse Equity Flow
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Foundry Median Metro

Module Opulent Oriel
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Origin Paper Solstice

Technic Trek Urban



20 · C1Olap Architecture

Verve

Using the Report Menu
From the Report menu, you can preview or print the report, set up the pages of the report, add header and/or 
footers, and specify which items to show in the report.

Print Preview Select Print Preview to preview your report before printing or to export to a PDF file.

Print Click Print to print the C1OlapGrid, C1OlapChart, or both.

Options Click Options to open the Document Options dialog box for 
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Document Options

The Page Tab

On the Page tab you can specify the Orientation, Paper Size, and Margins.
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The Header/Footer Tab

On the Header/Footer tab, you can add a header and/or footer to each page of the report. 

Click one of the buttons on the toolbar to insert fields into the header or footer. 

Button Field

Presets Choose from three predefined options containing groups of fields to be inserted in 
the header or footer.

Page Number &[Page]

Current Date &[Date]

Current Time &[Time]

Document Name $[DocName]

View Description &[ViewTitle]

Author Name &[UserName]

Check the Separator box to show a separator line below the header or above the footer. Click the Font button 
to change the font, style, size, or effects.

The Report Content Tab

On the Report Content tab, you can determine whether to include the Olap Grid, Olap Chart, and/or the 
Raw Data Grid in your report. You can also scale the items as desired and extend the last column of the grids.
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Olap for WinForms Task-Based Help
The task-based help assumes that you are familiar with programming in Visual Studio .NET and know how to 
use bound and unbound controls in general. Each topic provides a solution for specific tasks using the 
ComponentOne Olap for WinForms product. By following the steps outlined in the help, you will be able to 
create projects demonstrating a variety of Olap for WinForms features.

Each task-based help topic also assumes that you have created a new .NET project. 

Run-Time Tasks
The following topics describe how end users of your applications can interact with ComponentOne Olap for 
WinForms at run time. 

Removing a Field from a Data View
In the C1OlapPanel control or the C1OlapPanel area of the C1OlapPage control, you can filter out an entire 
field so that it doesn't appear in your C1OlapGrid or C1OlapChart data view. 

1. In the Drag fields between areas below section of the panel, select the field to filter out of the view.

2. Drag it to the Filter area of the panel. The data in this field will be removed from the C1OlapGrid or 
C1OlapChart data view.

Filtering Data in a Field
In the C1OlapPanel control or the C1OlapPanel area of the C1OlapPage control, you can filter the data in a 
field from the Drag fields between areas below section of the panel. Each field has two filters: the value filter, 
which allows you to check specific values in a list, and the range filter, which allows you to specify one or two 
criteria. The two filters are independent, and values must pass both filters in order to be included in the Olap 
table.

Using the Value Filter

1. Right-click a field in the Filter, Column Fields, Row Fields, or Values area.

2. Click Field Settings in the context menu. The Field Settings dialog box opens. 

3. Click the Filter tab. This is the value filter. You can clear the selection for any of the fields that you do not 
want to appear in the Olap table.
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Once you have selected the fields to appear in the table, you can specify a range filter by clicking the Text 
Filter or Numeric Filter button at the bottom of the window.

Note: If the field you are filtering contains numeric data, Numeric Filter appears instead of Text Filter.

Using the Range Filter

1. Right-click a field in the Filter, Column Fields, Row Fields, or Values area.

2. Click Field Settings in the context menu. The Field Settings dialog box opens. 

3. Click the Filter tab and specify the value filter, if desired. You can clear the selection for any of the fields 
that you do not want to appear in the Olap table.

4. Click the Text Filter or Numeric Filter button to set the range filter.

5. Select one of the following items. 

Clear Filter Clears all filter settings.

Equals Opens the Custom Filter dialog box so you can create a filter where items 
equal to the specified value are shown.

Does Not 
Equal

Opens the Custom Filter dialog box so you can create a filter where items 
that are not the same as the specified value are shown.

Begins With Opens the Custom Filter dialog box so you can create a filter where items 
that begin with the specified value are shown.

Ends With Opens the Custom Filter dialog box so you can create a filter where items 
that end with the specified value are shown.

Contains Opens the Custom Filter dialog box so you can create a filter where items 
that contain the specified value are shown.
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Does Not 
Contain

Opens the Custom Filter dialog box so you can create a filter where items 
that do not contain the specified value are shown.

Custom 
Filter

Opens the Custom Filter dialog box so you can create a filter with your own 
conditions.

6. Add an item to filter on in the first blank text box.

4. Select And or Or.

5. Add a second filter condition, if necessary. If you select an option other than None, the second text box 
becomes active and you can enter an item.

6. Click OK to close the Custom Filter dialog box and click OK again to close the Field Settings dialog box.

Specifying a Subtotal Function
When creating custom views of data, you may want to perform a different aggregate function other than "Sum" on 
your column or row. For example, you may want to find the average or maximum values in your data. This can 
easily be done through the Field Settings dialog box.

To specify the function performed on data, follow these steps:

1. Right-click a field in the Values area of the C1OlapPanel.

2. Click Field Settings in the context menu. The Field Settings dialog box opens.

3. Click the Subtotals tab.

4. Select one of the following options:

Sum Gets the sum of a group.

Count Gets the number of values in a group.

Average Gets the average of a group.

Maximum Gets the maximum value in a group.

Minimum Gets the minimum value in a group.

First Gets the first value in a group.

Last Gets the last value in a group.
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Variance Gets the sample variance of a group.

Standard Deviation Gets the sample standard deviation of a group.

Variance Population Gets the population variance of a group.

Standard Deviation 
Population

Gets the population standard deviation of a group.

5. Click OK to close the Field Settings dialog box. Notice how the values in the summary table change.

Formatting Numeric Data
You can format numeric data as currency, as a percentage, and so on or create your own custom format.

To format numeric data, follow these steps:

1. Right-click a field in the Values area of the C1OlapPanel.

2. Click Field Settings in the context menu. The Field Settings dialog box opens.

3. Click the Format tab.

4. Select one of the following options:

Numeric Formats the data as a number like this: 1,235. You can specify the number of 
decimal places and whether to use a 1000 separator (,).

Currency Formats the data as currency. You can specify the number of decimal places.

Percentage Formats the data as a percentage. You can specify the number of decimal places.

Scientific Formats the data in scientific notation. You can specify the number of decimal 
places.

Custom Enter your own custom format for the data.

5. Click OK to close the Field Settings dialog box. Notice how the values in the summary table change.

Creating a Report
In the C1OlapPage control, you can set up and print a report using the Report menu. 

To create the report, follow these steps:

1. Click the drop-down arrow next to Report on the C1OlapPage ToolStrip.

2. Select Options. The Document Options dialog box appears.

3. On the Page tab, select a page Orientation, Paper size, and set the Margins as desired.

4. Click the Header/Footer tab.

5. Place the cursor in the header or footer text box where you want to add text or a predefined header/footer 
item.

6. Click one of the buttons on the toolbar to insert the desired field.

7. Click the Report Content tab.

8. Check the check box next to the items you want included in the report. You can also select a radio button 
to change the scaling of the grid or chart.

9. Click OK to close the Document Options dialog box.
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Printing a Report
To print the report using the C1OlapPage control, follow these steps:

1. Click the drop-down arrow next to Report on the C1OlapPage ToolStrip.

2. Select Print. The Print dialog box appears.

3. Choose a printer from the Name drop-down list and click OK.
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